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Excel 

Excel, the Double-Click Tricks 

Copying a Formula down the column 

 

Rather than drag formulas down the column double-click the corner of the formula. 
Hover your mouse over the lower right-hand corner of the cell and wait for the Fill 
Handle (little black cross) to appear. Then double-click to copy the formula down the 
column. 

 

So long as there are no blank cells in the previous column your formula copies all the 
way down to the end. The end of what? The end of the previous column, that's why 
it's a really bad idea to leave a blank column between your last data column and the 
column used for the formulas. 

This double-click to copy down method is so much better than dragging that it's 
usually easier to delete your blank column, do the copying and then insert the blank 
column afterwards. 



Excel Shortcuts and Formulas 

2 
 

Adjusting Column Widths 

 

This method also works with row heights but it's dealing with column width 
problems where it really comes into it's own. 

We are all familiar with the column width problem where you have the hash signs 
displayed in your cells. The last thing you want to do is start dragging the column 
wider, instead hover your mouse over the right-hand edge of the column until the 
double-headed arrow appears and then double-click to apply an automatic column 
width. This is based on the longest entry in the column. 

Remember, work on the columns and not the cells containing the hash signs. If you 
have several columns to adjust, which is often the case, then select them first. Click 
on the first column letter and then drag across to select the others. Double-click 
between any two columns in your selection and all the columns are done in one go. 

Using the Format Painter 

 

Most of the MS Office applications have a Format Painter control which you can use 
to copy all the formatting from one place to another. That's ALL the formatting in 
one go. But just once. 
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What is not so obvious is that when you double-click the Format Painter you can 
repeat your formatting by continuing to click on additional items. The Format Painter 
stays on until you deliberately cancel it by pressing the ESC key or single-clicking the 
control. 

To use the Format Painter in Excel, apply formatting to a single cell or a range of cells 
and then either click (to paste the formatting once) or double-click. Now, select 
another cell or range and all the formats (fill colours, borders, fonts, number formats 
etc.) are copied from the source to where you have just clicked. As you do this you 
will see a paintbrush image attached to your mouse pointer. 

The Format Painter control is found on the Clipboard group (on the extreme left-
hand side) of the Home tab.  
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Movement and Selection 

You can double-click the border of the 
active cell to move it in any direction to 
the end of the current block of cell data. 

Double-click the lower border and you 
move down, left border and you move 
left, right border to move right etc. You 
always stop at the first blank cell. 

Instead of moving the current active cell, 
to select the range of cells down or across, 
hold down the SHIFT key as you double-
click one of the borders. You expand your 
current selection down or across to the 
first blank cell. 

Using the Keyboard 

You can do all of this with the keyboard if 
you prefer. To move the active cell, press 
the END key and take your finger off it. 
Excel is now in END mode. Now, press any 
one of the four arrow keys to move in that 
particular direction. 

Practice using the END key sequence a few 
times and then you can bring your SHIFT 
key into play to make selections. Hold 
down the SHIFT key and keep it held down 
as you press any one of the END and 
arrow key sequences. 
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Excel, the CTRL key tricks 

Copying and Moving 

 

Cut and Paste is most peoples's favourite method of moving data from one cell to 
another. A simpler alternative is Drag and Drop; point to any of the cell's borders, 
wait for the arrow pointer to display and then drag your data to another cell. 

If you want to drag your selection onto another worksheet, drag down to the sheet 
tabs and then hold down the ALT key to switch over to the other worksheet. 

 

To change your move into a copy (Copy and Paste), hold down the CTRL key as you 
drag. You should see that a plus sign is displayed next to the arrow pointer. Keep 
your CTRL key held down until you have released the mouse button. 

Cell drag and drop is usually enabled. Should you find that the arrow pointer does 
not display then you need to turn it on. The settings is in Excel Options (File tab), 
Advanced section, Editing options: Enable fill handle and cell drag-and-drop. 

Copying and Moving Columns and Rows 

Drag and Drop works in exactly the same way for moving or copying entire columns 
or rows. Just click the column letter or row number first to select it and then point to 
the edge of the selection. Drag to move or CTRL+Drag to copy. 
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Copying and Moving Worksheets 

 

The drag and drop method is equally effective for copying and moving entire 
worksheets. Point to the sheet tab and click, the document icon will display. Now 
drag to the left or right hand side to move the worksheet into a new position in the 
workbook. 

To make a copy of an entire worksheet, point to the sheet tab and click. When the 
document icon displays, hold down the CTRL key and you will see a plus sign 
displayed on the icon. Now, drag the sheet to the left or right hand side to create a 
copy. Try doing that with Copy and Paste. 

 

On some keyboards you need to hold down the CTRL first before clicking the sheet 
tab. 

If your worksheets are in different workbooks then you can still drag and 
drop your worksheets but you need to have both of the workbooks visible 
first. Arrange the documents on the screen by clicking the View tab,  then 
go to the Window group and click Arrange All, Tiled.  Drag to move a 

worksheet, CTRL+Drag to copy. 
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And the Shift Key 

 

When you drag and drop one cell onto another you usually overwrite the data in the 
destination cell or range of cells. 

But when you hold down the SHIFT key as you drag then you insert cells into the 
destination range without overwriting data. 

 

Watch the I-beam as you drag, the vertical I-beam means Shift cells right and the 
horizontal I-beam means Shift cells down. 

In the illustrations we took the 450 cell value over to the right and dragged it into 
the E5 cell position and the rest of the cell range moved down to accommodate the 
data insertion. 
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Filling Data with the Fill handle 

 

The Fill handle is that little black cross-shaped mouse pointer that appears at the 
lower right corner of the active cell. Not unreasonably, it is popularly known as the 
"little black cross". When you drag the Fill handle down or across you fill the data 
from the active cell across or down: formulas are copied, numbers are copied as 
constants and text stored in a Custom list, such as days of the week, triggers the list 
sequence. 

When you hold down the CTRL key as you drag you will see a plus sign displayed on 
the black cross and this reverses the normal behaviour of the fill. For example, if you 
drag a cell containing the value of 1 then the number 1 will remain constant but if 
you hold down the CTRL key then you will generate the sequence of values: 1,2,3,4 
etc. 

 

Normal text is copied as a constant but Custom list text is entered in the order of the 
custom list. Custom lists can be very handy; for example you type "March" into a cell 
then you drag to enter the other months of the year. 

But this can be irritating if you wish the month name to remain constant. This is 
where you hold down the CTRL key to reverse the usual action. Type in "March" and 
then CTRL+Drag to enter "March" into the cells below. 

Excel Custom lists can be viewed, edited and set up in Options (File tab), Advanced 
section, scroll down to General and click the Edit Custom Lists control. 
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Repeating Patterns 

 

Sequences of numbers may be generated by creating a seed pattern in a few cells 
and then selecting this seed pattern and dragging to extend the sequence. For 
example a plus 10 sequence is seeded by typing 10 and 20 into consecutive cells, 
then you select the two cells and drag to generate the sequence 10,20,30,40,50 etc. 

Repetitions of the seed pattern are obtained by holding down the CTRL key as you 
drag. The sequence of values is then repeated; 10,20,10,20,10,20 etc. 

Text values can be treated in much the same way, enter and select an initial pattern 
of text and then CTRL+Drag to create repetitions of the original. In the illustration 
below, we wanted the headings "Budget" and "Estimate" repeated across the top of 
a financial report. Instead of Copy and repeated Pastings the headings were dragged 
across to the right with the CTRL key held down. 

 

Making Selections 

 

A multiple selection of cells is where you select one range of cells and then you hold 
down the CTRL key and keep it held down as you continue to add to your initial 
selection and create a collection. 
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If you make a mistake then there's nothing to be done other than to click a cell to 
clear your current selection and start over again. 

This sort of selection is so useful for cell formatting as you can apply your formats to 
the entire selection in one fell swoop instead of having to format each range 
individually and invaluable where you want to plot cell ranges which are not 
immediately adjacent to each other on an Excel chart. 

Columns and Rows 

 

The same method of selection is easily applied to entire columns or rows by clicking 
the first column letter or row number, then you hold down the CTRL key and click on 
the others. 

With multiple rows selected you can apply actions such as deletion to all the 
selected rows or with multiple columns selected, as in the illustration, you can 
change the width of alternate columns in your worksheet. The more you use 
collections the more ideas you will have. Not all actions can be applied to a multiple 
selection but it is always worth experimenting. 

Worksheets 

In the illustration below we coloured alternate sheet tabs red in one go by holding 
down the CTRL key and clicking on the relevant sheet tabs. Right-click any selected 
tab to access the Tab Color command. 

 

And the Shift Key again 
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The other method of selection that is useful to know is Block selection which uses 
the SHIFT key. This is the selection of a continuous range of cells effected not by 
dragging, as is usual, but by clicking. You click the first cell of your selection, hold 
down the SHIFT key and then click the last cell. It's Click, Shift, Click. 

This feels very awkward if you never tried it before as you can not stop yourself from 
dragging but if you practice the technique on small ranges of cells then you will 
rapidly master it. And then you can apply in so many different situations: selecting 
huge ranges of cells, ranges of sheet tabs etc. 

 

Now you're an expert in the dark art of Excel cell selection you will find that you can 
use these selection techniques on other Excel objects and in other Microsoft Office 
applications.  

Extend Mode 

A final word on multiple selection, using your keyboard. The CTRL key with a normal 
mouse is the easiest thing in the world, you hold the key down with your left hand 
and select with your right hand. But left-handers don't always have such an easy 
time of it and some touch pads can make you wish that you had a third hand. This is 
where you need Extend Mode with the keyboard. 

Press function key F8 to open extend mode and then select your first cell range 
either using your mouse or by using your keyboard: hold down the SHIFT key and 
extend the selection by pressing your arrow keys. 

 

Now, lock your current selection by pressing SHIFT+F8 and then move on to make 
your next selection. This is best done by pressing the arrow keys to exit the current 
selection and then pressing SHIFT and arrow keys again to make the next selection. 
Press SHIFT+F8 again to lock this selection and continue in this way until the 
selection is complete. 

This is a lot easier to do than it is to read about it. 
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Excel Formulas 

There are hundreds of Excel worksheet functions available but you will see that 
knowing the primary operators and a dozen or so functions is usually all you need. 

Category Function 

Filtering SUMIFS, COUNTIFS 
Error correction IFERROR 
Text LEFT, RIGHT, MID, LEN, TRIM, UPPER, LOWER 

etc. 
Logical IF, AND, OR, NOT 
Lookup VLOOKUP, HLOOKUP, MATCH, INDEX 

 

Operator Meaning 

+ Plus 
- Minus 
* Multiply 
/ Divide 
$ Absolute reference. Dollar signs, press F4 
! External reference 
& Concatenation 
" " Literal text values in formulas 
= Equal to 

<> Not equal to 
> Greater than 
< Less than 

>= Greater than or equal to 
<= Less than or equal to 

Filtering 

Use SUMIFS and COUNTIFS rather than the older SUMIF and COUNTIF functions as 
they are more capable and have a slightly different order of arguments. 

COUNTIFS 

COUNTIFS(criteria_range1, criteria1) 

Formula to count the number of cells containing the exact word “Soap” in column B: 

=COUNTIFS(B:B, ”Soap”) 

Criteria_range is any range of cells and criteria is either the reference of a cell 
containing the value being used as a criterion or the literal value (i.e. contained in 
quotation marks) Text is not case sensitive. You may use wildcards (typically the * 
symbol) as placeholders for unknown values. Include extra criteria_range and 
criteria values to make the calculation more complex. 

Formula to count the number of cells containing the text “Soap” in column B: 

=COUNTIFS(B:B, ”*Soap*”) 
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Formula to count the number of cells with values which are one thousand or more in 
column C: 

=COUNTIFS(C:C, ”>=1000”) 

Formula to count the number of combinations of “UK” in column A and “Soap” in 
column B: 

=COUNTIFS(A:A,”UK”,B:B, ”Soap”) 

SUMIFS 

SUMIFS(sum_range, criteria_range1, criteria1) 

Formula to add the values in column C where there is the exact word “Soap” in 
column B: 

=SUMIFS(C:C, B:B, ”Soap”) 

Sum_range is a range of cells containing numbers, criteria_range is any range of 
cells and criteria is either the reference of a cell containing the value being used as a 
criterion or the literal value (i.e. contained in quotation marks) Text is not case 
sensitive. You may use wildcards (typically the * symbol) as placeholders for 
unknown values. Include extra criteria_range and criteria values to make the 
calculation more complex. 

Formula to add the values in column C where there is the text “Soap” in column B: 

=SUMIFS(C:C, B:B, ”*Soap*”) 

Formula to add the numbers which are one thousand or more in column C: 

=SUMIFS(C:C, C:C,  ”>=1000”) 

Formula to add the numbers in column C where there is a combination of “UK” in 
column A and “Soap” in column B: 

=SUMIFS(C:C, A:A,”UK”,B:B, ”Soap”) 

Error Correction 

Sometimes a perfectly good formula can produce an error value. For example, the 
formula  =A1/B1 returns a division by zero error (#DIV/0!) if cell A1 is empty even 
though the formula is valid. Error values like this need to forced out otherwise the 
worksheet is infected with ugly error values and other formulas which reference the 
error cell return errors. 

IFERROR(value, value_if_error) 

Formula to return the value of zero whenever A1/B1 returns an error: 

=IFERROR(A1/B1,0) 

Value is the original formula which could produce error values in certain situations 
and value_if_error is the value to substitute for the error value, typically zero 
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although it can be a cell reference or some literal text. 

Text Functions and Concatenation 

These formulas are all about being able to manipulate worksheet information 
without your having to spend ages retyping data. Typically this is data dumped from 
a database. 

Concatenation 

Either use the concatenation operator, & or the CONCATENATE function. They both 
do exactly the same job so the decision is entirely a matter of personal taste. 

Formula to return the text “Bill and Ben” where cell A1 contains “Bill” and B1 
contains ”Ben”: 

=A1&” and “&B1    or   =CONCATENATE(A1, “ and “, B1) 

If you want to use the CONCATENATE function, type-in “con” and then press the TAB 
key to extract the function from the list. Notice how for both formulas the word 
“and” has the leading and trailing spaces required inside the double quotation 
marks. 

Case conversion 

Use the UPPER, LOWER or PROPER functions to convert the case of any text which 
has been entered irregularly. The UPPER function forces capital letters, LOWER is the 
reverse and PROPER forces the initial capital letter case. 

You can not force a new case for the text in the same cell, instead you have to return 
the converted value and then replace the original data. For example, we have some 
badly typed data in column A which we wish to convert to the PROPER case. Enter 
=PROPER(A1) in cell B1 to convert the first value and then copy the formula down 
the column to do the others. 

We now have our converted text in column B but we must not delete column A just 
yet otherwise we shall have errors returned by our column B formulas which are 
dependent on the data in column A. To make the column B data independent we 
have to convert the formulas in column B to values. Select the column by clicking the 
letter B and then click the right-hand mouse button. Click Copy from the shortcut 
menu and then right-click again and look for Paste Values, the clipboard with 123. 

All the formulas are converted to constants and the original data in column A can 
now be safely deleted. 

Extraction 

You don’t always want the entire entry in the cell but only a part of it. You need to 
extract the required elements using the LEFT or RIGHT functions to extract a certain 
number of characters from either the left or right hand sides. Alternatively, use the 
MID function to read in from the left hand side to a certain position in the middle of 
the text and extract a certain number of characters from that point. 
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Cell A1 contains the word “FRED”, formula to extract the “FR”: 
=LEFT(A1,2) 

Cell A1 contains the word “FRED”, formula to extract the “RED”: 
=RIGHT(A1, 3) 

Cell A1 contains the word “FRED”, formula to extract the “RE”: 
=MID(A1,2,2) 

You often need other functions to assist in the extraction process, for example LEN 
to return the length of the text or FIND to locate certain characters in the text. 

Cell A1 contains the code “PR00987001”, formula to extract the code numbers from 
the 2 letter prefix. The number of characters in the code is unknown: 

=RIGHT(A1,LEN(A1)-2) 

Cell A1 contains the email address “fred.bloggs@mega.com”, formula to locate the 
“@” character and extract the text up to but not including the “@”: 

=LEFT(A1,FIND("@",A1)-1) 

Spaces 

Watch out for spaces in text, typically on the end of the text that you can see there 
are often space characters which you can not see and these invisible characters will 
cause errors to occur in any formula which is based on exactly matching text. 
Functions like SUMIFS, COUNTIFS, VLOOKUP, HLOOKUP and MATCH are particularly 
vulnerable.  

The space characters have either been typed in by a human being who learned to 
touch type many years ago and has the habit of pressing the spacebar after typing in 
every word. Try to be understanding with them. More likely it’s that your data 
originates from a fixed-length database field and the spaces are the padding 
characters. 

Use the TRIM function to remove any leading or trailing spaces from your data. 
Medial spaces are preserved, for example the space between Bill and Bloggs in Bill 
Bloggs is not removed whereas any spaces in front of Bill or after Bloggs are 
removed.  

Logical Decision Making formulas 

Some of the most commonly used functions in Excel formulas are those which can 
make decisions based on logical tests and outcomes and thus introduce an element 
of intelligence into worksheet formulas. 

The logical values TRUE and FALSE are returned by the comparative operators:  = 
(equal to), <> (not equal to), > (greater than), < (less than), >= (greater than or equal 
to), <= (less than or equal to) and are processed by the IF function. 

IF(logical_test, value_if_true, value_if_false ) 
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Cell A1 contains the value of 100, formula to return the word “Big” if A1 is 50 or 
more, otherwise the word “Small”: 

=IF(A1>=50,”Big”,”Small”) 

Multiply the value of cell C1 by 10% if cell B1 contains the word “Soap”, otherwise 
enter a zero: 

=IF(B1=”Soap”, C1*10%, 0) 

Multiply the value of cell C1 by 10% if cell B1 contains the word “Soap”, otherwise 
enter zero-length text which makes the cell appear to be empty: 

=IF(B1=”Soap”, C1*10%, “”) 

Your logical tests may need to be negative; either use the not equal to (<>) operator 
or use the NOT function to reverse the logic of any conditional test.  

Multiply the value of cell C1 by 10% if cell B1 does not contain the word “Soap”, 
otherwise enter a zero: 

=IF(B1<>”Soap”, C1*10%, “”)   or  =IF(NOT(B1=”Soap”), C1*10%, “”) 

Joining Logical Tests 

Your logical tests may need to be more complex and incorporate more than one 
conditional test. Use the functions AND or OR to join tests together. You can join 
several logical tests but the outcomes are as follows: 

When using the AND function. For the entire expression to be TRUE then ALL the 
tests must be TRUE. 

When using the OR function. For the entire expression to be TRUE then only one of 
the tests must be TRUE. 

Does A1 contain the word “UK” and does B1 contain “Soap”? 

=AND(A1=”UK”, B1=“Soap”) 

Is B1 “Dental” or “Soap”? 

=OR(B1=”Dental”, B1=“Soap”) 

Is A1 “UK” and is B1 either “Dental” or “Soap”? 

=AND(A1=”UK”, OR(B1=”Dental”,B1=“Soap”)) 

If the country in A1 is “UK”, ”France” or “Spain” then enter “Road freight”, otherwise 
“Air freight”: 

=IF(OR(A1=”UK”, A1=“France”,A1=”Spain”),”Road freight”, ”Air freight”) 

If the B1 value is not “Dental” and the value of C1 is 1,000 or more then multiply the 
D1 value by 10%, otherwise enter a zero: 
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=IF(AND(NOT(B1=”Dental”), C1>=1000),D1*10%, 0) 

Multiple Logical Outcomes 

Logical tests return TRUE or FALSE, only two possible outcomes. But a decision 
making process may have several different outcomes and to include this into your 
formula then it follows that additional logical tests must be made. One logical test 
gives two possible outcomes; two logical tests give three possible outcomes etc. 
Place the additional tests inside the original IF structure by taking up the position of 
the FALSE clause so that if the first test returns FALSE then the second test is 
executed. As usual, if none of the tests return TRUE then the entire formula returns 
the FALSE value at the end. 

IF(logical_test, value_if_true, IF(logical_test, value_if_true,  value_if_false )) 

There are limits to number of times that you can call the IF function in your formula 
as there are limits to the number of tests that can be combined with the AND and 
OR functions but they are so high that, in practice, you would probably not have to 
consider them. 

What is worth consideration is whether your formulas can be understood by a 
normal, intelligent person. Try to document any complex and dense formulas to stop 
their becoming “black boxes” which can only be understood by their original author. 
Often a simple lookup table is a more efficient and much easier formula than a very 
complex nested IF. 

If the country in A1 is “Greece” then enter “Donkey”, if not then if the value is “UK”, 
”France” or “Spain” then enter “Road”, otherwise enter “Air”: 

=IF(A1=”Greece”, ”Donkey”, IF(OR(A1=”UK”, A1=“France”,A1=”Spain”),”Road”, 
”Air”)) 

Calculate a discount rate; if C1 is 2,000 or more then it’s 10%, if C1 is between 1,500 
and 2,000 then it’s 8%, if C1 is between 1,000 and 1,500 it’s 6%, otherwise it’s zero: 

=IF(C1>=2000,10%,IF(AND(C1>=1500,C1<2000),8%,IF(AND(C1>=1000,C1<1500),6%,0
))) 

That last example has four possible outcomes; 10%, 8%, 6% or zero. It’s already too 
dense to be easily understood and it is a good candidate for being replaced with a 
lookup table. 
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Lookup formulas 

Lookup functions automate the cross-referencing process and are invaluable for 
matching and checking worksheet values. Got a list of 50,000 bar codes in column A 
and you want to look up the corresponding SKU in column AQ? You need a lookup 
formula. 

The most commonly used lookup function is VLOOKUP (for vertical tables), not so 
commonly seen is HLOOKUP (for horizontal tables) MATCH is a very useful function 
to know and is often used in conjunction with INDEX in situations where VLOOKUP 
can’t do the job. These Excel functions have been around for donkey’s years, they 
date back to at least the 1980’s and everyone uses them. They are not what you 
would call “common sense” but if you learn and implement their rules then you will 
find them very useful and quite straightforward. 

VLOOKUP or HLOOKUP? 

Is your worksheet data arranged vertically or horizontally?  

Day Name Amount 

Mon Fred 100 

Tue Barney 125 

Wed Wilma 250 

Thu Betty 124 

Fri Pebbles 678 

Above is a VERTICAL table. Use VLOOKUP to cross reference the table values. From 
the Day of the week you can retrieve either the Name or the Amount. The vertical 
lookup process is where you match a value in the first column, say “Wed” and then 
read across to the right hand side to return a value that is in the same row but 
entered into a different column; say “Wilma” or 250. In your formula you specify 
which column not by giving its column letter but instead by giving its index—its 
position in the table. The first column is 1, the second column is 2 etc. The actual 
column letters are never used.  

Most lookups use VLOOKUP as it is natural to create tables by entering headings and 
then listing data under the headings. The same class of data is entered down the 
column but as each row represents a record the relationship of the data elements is 
across the row. 

Day Mon Tue Wed Thu Fri 

Name Fred Barney Wilma Betty Pebbles 

Amount 100 125 250 124 678 

Above is a HORIZONTAL table. Use HLOOKUP to cross reference the table values. 
From the Day of the week you can retrieve either the Name or the Amount. The 
horizontal lookup process is where you match a value in the first row, say “Wed” and 
then read down the column to return a value that is in the same column but entered 
into a different row; say “Wilma” or 250. In your formula you specify which row not 
by giving its row number but instead by giving its index—its position in the table. The 
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first row is 1, the second row is 2 etc. The actual row numbers are never used.  

In a horizontal table, the same class of data is entered across the row but the 
relationship of the data elements is down the column. 

Exact Match or Approximation? 

Both the VLOOKUP and HLOOKUP functions can exhibit two distinctly different 
behaviours, an Approximation lookup or an Exact Match lookup. You need to 
specify which one you require by completing the fourth argument value 
Range_lookup as follows: 

 TRUE or numeric 1 for the Approximation 

 FALSE or numeric zero for the Exact Match 

If you do not enter the forth argument then both functions will default to TRUE and 
give the Approximation lookup. 

 

VLOOKUP(lookup_value, table_array, col_index_num, range_lookup ) 

HLOOKUP(lookup_value, table_array, row_index_num, range_lookup ) 

Lookup_value is the value that you’re looking up either as a literal value or a cell 
reference, table_array is the cell references of your data, col_index_num (or 
row_index_num) is the column (or row) in table_array from which you wish to 
retrieve your data and range_lookup declares which type of lookup to perform; 
Approximation or Exact Match? 

In the example above we are looking up the Name for the Day “Mon”. A1 is the 
lookup value, B3:D8 is the range containing the data, we want the Name which is in 
the second column in the range B3:D8 therefore the column index is 2. The formula 
returns “Fred”—the corresponding name for Mon. 

=VLOOKUP(A1, B3:D8, 2) 

But the formula is not working properly as when we enter different days of the week 
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we obtain the following results: 

Mon Fred 

Tue Barney 

Wed Pebbles 

Thu Fred 

Fri Name 

Obviously wrong! What went wrong? We did not specify the forth argument, 
range_lookup and as a result our formula has done an approximation lookup. In an 
approximation lookup your lookup values must be in strict ascending order in order 
for the approximation to work properly. But this would mean our sorting the days of 
the week into alphabetical order: Fri, Mon, Thu, Tue, Wed which would look 
ridiculous.  

We are using unsorted text as our lookup values so we should specify an Exact 
match lookup by entering the following formula: 

=VLOOKUP(A1, B3:D8, 2, FALSE)  or  =VLOOKUP(A1, B3:D8, 2, 0) 

Zero is the numeric equivalent of the logical value FALSE so it does not matter which 
value you use but you must complete the forth argument to make your formula 
return sensible results. Notice how “Mon” in A1 returns “Fred” but “Mon “ i.e. the 
right word but with a space on the end returns the infamous lookup error value 
#N/A. The text does not match exactly because of the space on the end. To avoid 
this type of problem you should either assassinate people who are forever typing 
spaces on the end of words or allow for them by incorporating TRIM into your 
formula to remove the space as follows: 

=VLOOKUP(TRIM(A1) , B3:D8, 2, FALSE) 

When do you need an Approximation? 

As most lookups are Exact match VLOOKUPs the approximation lookup is often 
ignored but it does have a crucial place in our formulas. You use approximation 
lookups when you need to classify data, typically it is numeric data that is used but 
the lookup works with text data. Make sure that your lookup values are sorted in 
strict ascending order. 
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In the above example we want to enter the correct bulk discount rate, which is 
based on the column C values. Rather than enter a complicated IF formula we have 
created a simple lookup table with the discount thresholds and the corresponding 
discount rates. The first units figure is 2,500 for which we do not have a match in our 
lookup table, but we do have a category. 2,000 or more units earns a 10% discount. 
None of our Units figures have an exact match in the lookup table but they can all be 
classified. This is approximation. 

 
Be careful when you copy a lookup formula, like all formulas you need to be careful 
with absolute references, you usually need to fix the table_array range. In the above 
illustration the first formula in column E is: 

=VLOOKUP(C2 , $G$4:$H$8, 2) 

The dollar signs for the table_array are required as we did not want it to change 
when the formula was copied down the column. Notice that there is no rounding in 
an approximation. 

MATCH and INDEX 

VLOOKUP matches an item in the first column of a lookup table and then looks 
across to the right hand side to retrieve values which are in the same row as the 
matching item but are entered into a different column. It does not look over to the 
left. How do you do a look-to-the-left lookup? Don’t use VLOOKUP, use a 
combination of MATCH and INDEX instead. 

MATCH is a useful function to know anyway as it is perfect for the job of matching 
(that surprised you!) 

VLOOKUP to the left 

In the illustration below we have a units figure and we want to know which country 
it relates to. Lookup to the left, locate the number in column C and retrieve the 
corresponding value from column A. VLOOKUP will not do this. 
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Firstly use the MATCH function to find where the value is in column C. The formula 
is: 

=MATCH(F1, C:C, 0) 

F1 is the value to match, column C the range in which to match and the match type 
is zero. Zero match is the first unique match. Just like VLOOKUP, MATCH does not 
cope very well with duplicate values. Should the formula return a value, then the 
match is made. In this case the match value is 7 telling us that the value is available 
on row 7 of column C.  

 
Now we can locate the corresponding country in column A, it must be the entry on 
row 7. Use the INDEX function to reference column A using the match value. You 
usually combine MATCH and INDEX into one formula as follows: 

=INDEX(A:A, MATCH(F1, C:C,0)) 
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Using MATCH for Matching 

Cross-checking worksheets can be a very time consuming job especially when you 
would rather spend your time investigating the differences. Let MATCH find the 
differences. 

 
In this example we have two worksheets, they can be in the same workbook or 
separate workbooks. We need to cross-match the values in the Ref column in 
column C. As usual, there’s hundreds of rows of data, it’s hard to read and we have 
to go through it all and identify the differences between the two sheets. 

 
Enter the MATCH formula to match the first item in the column to the corresponding 
column on the other worksheet. Where MATCH returns a value the match is made 
and when it returns the error value #N/A then there is a difference.  

Finally sort the column in descending 
order to gather all the mismatches. 

The process now needs to repeated 
by matching the other worksheet to 
this worksheet and the two 
documents have been cross-
matched. 
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Conditional Formatting 
 

Conditional Formatting on the Home tab controls the font, border and 
pattern formats that are applied to the cells under different conditions. 
To create a conditional format click the control and examine the fly-out 
menus to set a rule and specify a format. Or go straight to New Rule. 

 
 
 
 
 
 
 
 
 

 

In the illustration above Data Bars 
have been applied to a column of 
values to graphically show 
comparative values and an Icon 
Set has been added to another 
column. 

 
Click More Rules when you want 
to edit the rules that apply for 
bars, scales and icons. 

 
 
 
 
Usually it is the value in the cell that sets the formatting criteria but you can use the 
values in other cells to control the appearance of the cells in your current selection 
by using a formula to set the conditional format. For example we want the value in 
cell A1 to determine whether row 4 is coloured red. 
 

Select row 4, the cells to be 
formatted and then set the rule 
by clicking New Rule. In the New 
Formatting Rule dialog Select 
Classic form the Style list and 
then Use a formula to 
determine which cells to format. 

 
You must enter a formula that 
evaluates to either TRUE or 
FALSE. Then set the formatting 
you want to apply when the 
formula returns the value TRUE. 

 
In this case the formula is: 

 
=$A$1>100 

 
$A$1 is absolute as it is the value in A1 that governs the format for row 4. Had we 
wanted the values in row 1 to set the format of the cells in row 4 then the A1 
reference would have been relative, like this =A1>100. 
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Document Protection 

This does work; it’s the design that can confound you. The theory is that all 
worksheet cells are locked but the effect of this locking is not implemented until the 
worksheet is protected. 
 

So, to protect a sheet but leave a certain area open 
for entry you select the area, click the Format control 
on the Home tab and choose Lock Cell. Then protect 
the sheet by clicking Protect Sheet. Enter a password 
and check any options if required. All cells are now 
locked except for the input areas specified earlier. 

  

Procedure to Protect All the Formulas in a Worksheet 

1. Select all of the cells (CTRL+A) and unlock them by clicking Home tab, Format 
control, Lock Cell.  

2. Home tab, Find & Select control, Formulas to select the formula cells you 
want to have locked and then… 

3. Home tab, Format control, Lock Cell to reverse the unlocking for your 
formula cells.   

4. Protect the sheet. Home tab, Format control, Protect Sheet. 
 
The caption of the Lock Cell control never changes; it’s the background to the 
padlock that shows the current state of the control. 
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Auto and Advanced Filters 

Excel has two methods of filtering, the modern design AutoFilter which is very easy 
to use and an older design, Advanced Filter which is rather more awkward to use 
and which only should be considered if the AutoFilter is not capable. 
 

To turn on the AutoFilter view, click the control on the Data tab, 
each heading in your list will then have a drop down control 
which you use to apply a variety of filters to the list. The list is 
filtered in place with any rows which do not comply with the 
filter temporarily hidden. 

It’s easy to apply a 
filter by clicking the 
various options. 

 
Complex criteria are 
created by using the 
filter settings on 
more than one 
column. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Advanced Filter 
 
This takes a little longer to set up compared to AutoFilter. You need to copy the 
header row of your list at least once in order to create a criteria range and if you 
want to extract from the list then a second copy of the header row is required. 
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Click a cell in 
the body of 
your list and 
click the  
Advanced 
control in the 
Sort & Filter 
group of the 
Data tab. Drop 
down on the 
filter control 

 
The List 
range is 
completed 
automaticall
y, 
  
Criteria range 
is your second 
set of headers 
PLUS the blank 
row below. 

Copy to is your third set of headers and is used if you wish to extract from the list. 
Otherwise the list is filtered in-place. The Copy to range must be on the same 
worksheet, you only need to specify the header row, any data extracted will be 
returned below the headings. 

To filter your data, enter criteria expressions into the blank 
cells below the second set of headers and click the Advanced 
control again. Here we are extracting a list of all the records 
where the Country starts with an “f” and the Region starts 
with “s”. 
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Pivot Tables and Pivot Charts 

A PivotTable report is an interactive report that combines and compares data in your 
list. You can rotate the rows and columns to see different views and summaries of 
the source data and display the details for summarised values. Each column in your 
list becomes a field in the report, columns containing numbers are usually the value 
fields and columns containing text become row, column or filter page fields which 
are used to classify the data in the value fields. 

 
To create a report, click a cell in the body of your list and click the 
PivotTable control on the Data tab. You will see that your data cells are 
automatically captured and you are prompted to select where you want 
the report placed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click the various fields in the field list to 
produce your report; Excel guesses how 
to classify your fields. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

It’s easy to rearrange the fields by dragging 
them between the different areas. 
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Pivot Tables are not formulas, when you change the data in the source you 
must remember to refresh your Pivot Table to reflect the changes. It’s easy 
to do but easy to forget. Either right-click a Pivot table cell and choose 
Refresh or look for the Refresh control on the ribbon. Refresh is ALT+F5 
Refresh All is CTRL+ALT+F5. 
 

Pivot Charts 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pivot Charts are created by clicking the Pivot Chart control on the Options tab. The 
entire dataset is plotted on your chart which can make the chart rather cluttered. 
 
However, it is a simple matter to apply a filter to the field, in this example the 
Product field has been filtered to compare only two different products.  
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Creating Drop-down lists 
 

Validation lists are used where you want to restrict the entry made in a 
cell to only those items available in a drop-down list. The list of valid 
entries can be typed in or you can refer to a range of cells that contains 
your valid entries. The range of valid entries can be entered into a 
different worksheet in the same workbook. 

 
Data Validation lists are ideal not only where you need to make sure that people 
make the right entry but also for data entry generally as it is so easy to choose from 
a drop-down list. To create the validation list, select the cell or range of cells where 
you want the list to be displayed and then click the Data Validation control on the 
Data tab. 
 

In the Settings tab, choose List from the Allow drop-down list and 
then type in a comma-separated list of your valid entries into the 
Source box. Click the OK button and you're done. The list is available 
when you click on one of the cells where the validation has been 
applied and data entry in the cell is restricted to only those items in 
the list. Click the Error Alert tab if you want to change the standard 
"the value you entered is not valid" error message for invalid 
entries. You may prefer something a little more personal. 

 
A range of cells is preferable for your data validation where you 
either have a long list or you want to be able to change the list 
regularly. 

 
You can set the Source data validation as either a horizontal or 
vertical range of cells or an entire column or row. Either type in the 
range reference or (far easier) select the range or click the column 
letter or row number. 

 
If you click the column letter then remember that any heading at 
the top of your list on the worksheet will be included as the first 
item in your validation list. But if you add to the list on the 
worksheet then these additional items will automatically appear in 
the validation list. So there are advantages and disadvantages to 
selecting the whole column. 

 
If you specify a range of cells then you don't have the headings issue to deal with but 
if you then add to the list on the worksheet then you will also have to remember to 
reset the Source data range to include your additions. 

Dependant Data Validation lists 
 
Sometimes you need the choice that you have made in one list to control the list 
shown in another cell; one of your validation lists is dependant on the other. 
 

In the illustration there are two columns, the first column 
shows the class of date required, "Month" or "Day". This 
is entered from a simple comma separated validation list 
which is typed in. The second column needs to show 
either a list of months if "Month" is entered in the 
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corresponding cell in the first column or a list of days if 
"Day" is entered. 

 
There are two ranges of cells in the worksheet named as 
Month and Day respectively which are going to be the 
alternative source ranges for the second column. When 
you set the source data range for the second column 
enter the following formula: =INDIRECT(A2) 

 
Where A2 is the first cell in the first column where you have your "Day" or "Month" 
entry. Of course, you should change this cell reference to suit your own worksheet. 
The INDIRECT function is well named as it makes the reference indirect, i.e. not A2 
but the range reference entered in A2. In other words, if it's "Day" then show the 
Day list, if it's "Month" then show the Month list. You're not restricted to just having 
a choice between two alternative lists, with this method you can have the choice of 
as many different lists as you like. 
 

Displaying the drop-down list in alphabetical order 
 
The drop-down list is linked to the values in the worksheet cells, so sort the list in the 
cells in alphabetical order if you wish to show the drop-down list in the same order. 
But you can't have the drop-down list in a different order. 
 


